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1.0 Search Basics 

This Annex will show you how to search for records.  It explains searching using a single search criteria and how to combine several search methods to perform an advanced search.

1.1 Simple Search


Simple Search is an enquiry where you use only one search criteria to look for the record(s) you seek.  A Simple Search in RAMP-TRIM can be progressively refined by adding search values to pinpoint the record(s) you require. You do this by selecting Advanced Search, where you may choose how you want to expand or refine your search.

1.1.1 To do a Simple Search


Choose Find from the Search menu to display the Find Records dialog box: Alternatively you can click on the Search Button on the ToolBar or press CTRL F on the Keyboard.

1.1.2 Search Criteria
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The Search By area at the top of the Search Dialog Box is where a Search Criteria can be selected from a Drop Down List     or the KwikSSelect    

The Drop Down List will reveal a listing of Search Criteria which can be customized.  The Kwik Select will open the Search Methods Dialog Box
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Figure 1.  Search Menu



Word Searches

Title Word

Notes Word

Any Word

Document Content

Thesaurus Term

Record Plan (Select by Text)

Field 1

Field 2

Field 3



Navigate

All Records Related to

Latest Part of the Record

All Parts of the Record

Container of the Record

Records Contained in

Records with same Contacts as

Records with same Organizations as

Series Record for

Records in the Series



Trays

Work Tray Contents

Due for Action

Records In–Tray



Numbers

Record Number

Record Number Range (Expanded)

Record Number Range (Compressed)

External Reference

Record Plan (Select by No) 

Records Contained in

Barcode

Accession Number

Number 1

Number 2

Number 3

Cost 1

Cost 2

Cost 3



Dates

Date Registered 

Date Created

Date Closed

Date Modified

Requested by (Date)

Date 1

Date 2

Date 3



User Defined Fields

Field 1

Field 2

Field 3

Flag 1?

Flag 2?

Flag 3?

Number 1

Number 2

Number 3

Cost 1

Cost 2

Cost 3

Date 1

Date 2

Date 3



Archiving

Schedule Number

Consignment Number

Pending Event

Disposition Changes



Locations

Contact

Organization Name

Author

Addressee

Representative

Other Contact

Current Location

Home Location

Owner Location

Documents Checked Out

Requested by (Location)

Previous Location

Last Movement date

Workflow

Attached Actions

Overdue Actions

Actions in Progress by Location

Procedure with Late Action

Date Due



Miscellaneous 

Records Not Marked (Census)

Records Relocated (Census)

Records with no Container

Records not in Container

Missing Records

Security Level



Space Management

Records whose Home Space is

Records in Space System

Records currently at Home in Space

1.1.3 Search Values

Once you have selected a Search Criteria (Search By), then you can enter a Search Value. This is where you tell RAMP-TRIM what you know about the record(s) you're looking for - the criteria and values that the records must match.  Where KwikSelect is available, you can use the resulting list to choose the word, number or other value that you want to search by. 

1.1.4 Record Type Button

This button allows you to nominate the "type(s)" of record you wish to search for eg.  Folder, Document or any other record type you have defined.  Press the Record Type button and a dialog box will appear listing the searchable Record Types.  If a Record Type has a “tick”[image: image2.png]


 next to it, it will be included in the Search.  The absence of a “tick” [image: image3.png]


 indicates the Record Type will be excluded from the Search.  To remove a “tick” [image: image4.png]


, place your mouse over the tick and click the mouse, the tick for that Record Type will disappear.  To add a “tick” place your mouse in the area where the tick is normally displayed and click the mouse, a tick for that Record Type will appear.  Alternatively highlight the appropriate record type and click the right (secondary) hand mouse button, a short cut menu will appear and select Tag All or Untag All.  Choose the "Save as Default" flag if you want this to be permanent.

Choose the Do Search button to display the results of the search.  Press your right hand (secondary) mouse button in the view pane of your records and select Options to tell RAMP-TRIM what information you want to see for the records listed. 

1.2 Multiple Field Search Form
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Figure 2.  Multiple Field Search Form

The Search Dialog can be displayed in another form; the Multiple Field Search Form. The Multiple Field Search Form contains some of the most commonly used Search Criteria.  This Form allows users to fill in appropriate Search Values for some or all of the listed Search Criteria.  If a value is not entered into a Search Criteria, the blank criteria or criterion is not included in the Search.  All the field values will be combined in an AND search. 

Record Type:

This field allows you to search for either one or all record types.  

Words:


You can enter several words and they will be combined with an AND. In Title, In Notes, In Document Text.  You can choose which search method you want to apply to the above words.  If you select more than one, they will be combined with OR.  

Contacts:


You can enter two contacts that you want to search by.  They will be combined with OR.

Current Location:


Enter the value of the current location of the record that you are looking for.

Container Record:

Enter the value of the container for the record that you are looking for.

External Reference:

Enter the External Reference for the record that you are looking for.

Date Created:


Enter a Date Range, words (i.e. meta-variables e.g. LAST WEEK) do not work for this field.

Pressing the Advanced button will present you with the standard RAMP-TRIM advanced  Search dialog.  

1.3 Refining a Simple Search

When the list resulting from a search is too long and you want to refine the list to pinpoint the records you're looking for, choose Refine from the Search menu.  This re-displays the Find dialog box with the current search values.  Altering the search values and choosing Do Search refines your search so the list matches both the first set of search values and the new set.  

1.4 Advanced Search

An Advanced Search is an enquiry where you may enter more than one search value to find the record(s) you want.  When doing an advanced search, you may choose how your search criteria and values are combined to refine or expand the search.  

To do an Advanced Search:

Choose Find from the Search menu to display the Find Records dialog box.

Enter your first search criteria and value.  See page 4 for more information about search criteria and values.
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Figure 3.  Search Window

Choose the ‘Advanced >>>’ button.

RAMP-TRIM will automatically insert a new row if you have entered a valid value before choosing the Advanced Button.  

(Tip
By default RAMP-TRIM will insert the same Search Method that was

previously entered.  This can be changed by selected another Search Criteria from either the Drop Down List or Kwick Select buttons on the Search By edit box 

(Tip
The New or Insert buttons can be used to insert the next search value.  

The New button puts the new search value at the bottom of the Current Selection list.  The Insert button inserts the new search value just above the currently highlighted value in the Current Selection list.

Enter your next search criteria and value.

Choose how you want the search values combined.  See below for an explanation of the options for combining sets of search values.

If you want additional Search Criteria, press the New or Insert buttons to insert the next search value.  The New button puts the new search value at the bottom of the Current Selection list.  The Insert button inserts the new search value just above the currently highlighted value in the Current Selection list.

Repeat Steps 5 to 7 until all required search criteria and values have been entered.  The maximum number of rows in an Advanced Search is 50.

If you want the records from your search sorted in a particular order, choose the Sort/Filter button and tell RAMP-TRIM how you want the list presented.

Choose the Do Search button to display the results of the search.  In the view pane area hold down your right mouse button and tell RAMP-TRIM what information you want displayed from the options provided (see Record View Pane on page Error! Bookmark not defined. for further information).

1.5 Combining Search Values

The options available for combining sets of search values during an Advanced Search are:

1.5.1 AND

To refine a search to find only records which meet both the current search value and the previous search value.  This narrows a search, returning fewer records in the List Pane but pinpointing the required records.  

1.5.2 OR

To expand a search to find all records which meet either the current or previous sets of search values.  This broadens a search, returning more records and including a wider subject range.

1.6 Advanced Search Commands

The following command buttons are used to enter and alter the sets of search values listed in the Current Selection box during an Advanced Search:

1.6.1 New

Adds a new set of search values at the bottom of the list in the Current Selection box.

1.6.2 Insert

Inserts a new set of search values just above the currently highlighted value in the Current Selection box.

1.6.3 Delete

Deletes the currently highlighted value(s) from the Current Selection box.

1.6.4 (...)

This button is used to group sets of search values by putting them in brackets.  This has the effect of mathematical brackets, whereby values bracketed together are always dealt with together as one by any preceding or following operations.  This button will remain greyed until two or more lines of selection values are highlighted.  You can highlight a number of lines of selection values by holding the shift key and pressing the up or down arrow keys to highlight multiple items, or by dragging from one line to another with the left mouse button held down.

1.6.5 NOT

Refines a search to include only records that meet the previous but not the current set of search values.  It can only be used in conjunction with the AND operation. 

1.6.6 NOT(...)

When two or more search rows are highlighted, the Not Button changes to the Not(...) Button.  This will enable you to perform a search that excludes the search rows that are inside the brackets.

1.6.7 Reset

Deletes all of the search values from the Current Selection box so you can start a fresh search.

1.7 Sorting Search Results (with Filters)

When Sort/Filter is chosen from the Search dialog box the following options are used to both tell RAMP-TRIM how to sort the records displayed in the List Pane and also which records are to be included according to set filters.

1.7.1 Sort Fields

Use the drop-down list to choose the fields by which you want the List Pane sorted, for example by Number or Title.  You can specify one, two or three sort fields.  The list will be sorted first by the field in the first box, then by the field in the second box and finally by the field in the third box.

1.7.2 Descending

By default a list is sorted in ascending order of its sort field; that is, with the lowest numerical, date or alphabetical value at the top of the list and the highest value at the bottom.  If you want to reverse this so the highest value is at the top and the lowest value is at the bottom of the list, check the descending box next to the sort field you want reversed.

1.7.3 Disposition Filters

Each record has a "disposition".  You may set the Filters according to which records you want included or excluded from your search result list.  Setting the disposition filter allows you to include or exclude archived records form search result lists, possibily saving many unnecessary records from being listed. 

1.7.4 Class Filters

Each record has a set "class".  You may set the Filters according to which records you want included or excluded from your search result list.

1.7.5 Save Filters

If you make any changes to filter settings and you wish them to be saved for future search lists, then set the save flag.   The Save Filter does not save the sort options.

1.7.6  Saved Search

If there is a particular kind of search that you do frequently, then "saving" the search criteria can speed the process of doing searches in the future.  This function is particularly useful if you do frequent types of searches e.g. all correspondence registered today, this week etc.

RAMP-TRIM comes with variable names that can be typed in for date searches.  For example, if you save a search for records registered today, then you will have a quick method to search  for records created that day. 

Today

Tomorrow

Yesterday

Previous, this, next week

Previous, this, next month

This year

Year to date

Previous 7 days

Next 7 days

Previous 14 days

1.7.7 To save a search

Do the following:

Perform a search for records, using the criteria you wish to save for future use

When the result of the search is displayed, choose Save from the File menu
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Figure 4.  Saved Search Window

A New Saved Search dialog will be displayed, enter the following details

Name

Enter a name for your search.  Choose a title that will be easy to identify the next time you choose the Saved Search list.  Maximum of 30 characters.  Each Saved Search Name must be unique to the database

symbol 183 \f "Symbol" \s 10 \h Description

The description allows you to enter a more detailed Description of the Search.  By default RAMP-TRIM inserts the Search Criteria.

Public Search/Privately Owned By (System Administrators Only)

Check the Public Search option if wish to make the saved search available to other people on the network

Check the Privately Owned By option and insert the name the user that the Saved Search has been made for.  The Saved Search will appear in the specified user’s saved search list.  All RAMP-TRIM users, other than an Administrator, will be able to save a privately, owned search.  The Administrator may see all Saved Searches. 

Edit Query Button

The Edit Query button allows you to change the search method for this particular search.  

Choose OK to save the Search

1.7.8 To perform a search using saved criteria

Choose Saved Searches from the Search menu.  Highlight the saved search you wish to use and choose OK.  A Saved Search can be modified or removed at any time simply by pressing the Edit Query Button prior to running the search.  The Edit query Button is only available to a Systems Administrator on a Public Search. 

1.8 Other Search Menu Options

1.8.1 Count

Displays the total number of records returned from the search.

1.8.2 Directory

Displays an alphabetical list of all staff members in the RAMP-TRIM database with their corresponding phone numbers.

1.8.3 RAMP-TRIM Trays

1.8.4 Records In-tray

RAMP-TRIM can display any records marked to the current location of the Login name or the Login's position.  To see this, choose the Records In-tray option from the Search Menu (or click the "IN" search icon if you've set it up in your tool bar.)

1.8.5 Records Due

RAMP-TRIM can display any records that meet the following criteria:

SYMBOL 183 \f "Symbol" \s 10 \h
the Login name has been assigned as a responsibility for actions AND the 

action is currently in progress (ie. prior actions have been completed)

SYMBOL 183 \f "Symbol" \s 10 \h
the Login name's position has been assigned as a responsibility for actions AND 

the action currently in progress (ie. prior actions have been completed)

To see this, choose the Records Due option from the Search Menu (or click the "DUE" search icon if you've set it up in your tool bar.)

1.8.6 Records In or due

RAMP-TRIM can display a combination of the two options above.

1.8.7 Work Tray

Displays the "Work Tray" of the logged in user.  Records may be copied to the Work Tray window by doing a search and highlighting a single record or tagging multiple records and then choosing Copy to Work Tray from the Edit menu.  Records copied to the work tray may have any of the normal functions performed on them now, or in the future by any person logged in eg. changing location, boxing files etc.  The Records will remain in your Work Tray until they are cleared.  

To clear records from the Work Tray once you have completed your processing or tasks, tag the records you wish to remove then choose Clear from the Edit menu.

1.8.8 Recent Container

The Recent Container option will present a list of the last 10 containers that you have used.

1.8.9 Recent Documents

The Recent Document option will present a list of the last 10 documents that you have used.

1.9 Wild Card Searching

The Search Criteria of Title Word, Notes Word or Document Content will allow the use of a Wild Card.  You must enter at least the first three character of the word you are searching for and then an asterisk *.  

For example if I needed to find all records that had the Title Word of Consult, Consultant, Consultation or Consultative, I could perform a search on the search criteria of Title Word with a search value of Consult*.  

The Wild Card should be used with great caution, as the search result may return many more records than you are expecting.

For example if I perform a search on the search criteria of Title Word with a search value of Bud* to find all records with Budget or Budgeting in the Title.  This search will return all records with Budget or Budgeting in the Record’s Title, however it will also return all records that have Bud* in the Title such as Buddhism, Buddy, Budge or Budgerigar. 
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You can see how many records match your word by typing in the part of the word you want to search value field (with out the asterisk) and pressing the Kwik Select button.
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RAMP-TRIM will present you with a list of all words that match what you have typed in.  The In Titles column of the dialog box will show how many occurrences of the word are in RAMP-TRIM.  Therefore the Consult* search will find a maximum of 21 Records.  If you are happy with the maximum number, press the Cancel Button and insert the asterisk and perform the Search.  The embedded asterisk is not allowed, e.g. acco*dation. 
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The Search Methods Dialog Box displays all the Search Methods within RAMP-TRIM divided into logical categories.  To access a category click on the � next to the category title and the Search Methods will be displayed















































� If a caption has been changed on a Record Type, RAMP-TRIM will only display the changed caption when searching across that single Record Type.  If searching across more than one Record type, RAMP-TRIM will display the default captions


� If necessary, refine your search by choosing Refine from the Search menu.  Alternatively, choose the Advanced button to expand or refine your search before the search is performed.





� “In Document Text” is only available if Document Content Searching is licensed
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Figure 1.  KwikSelect Icon



